
Statistics
Surface Charts, Contour Charts and Heat Maps

1. Introduction:
Welcome to the e-Learning session on Surface Charts, Contour Charts and Heat Maps. In this module 
we are going to cover the meaning and steps to construct the Surface Chart, Contour Chart and Heat  
Maps.

By the end of this session, you will be able to: 
• Explain Surface Charts and different types of Surface Charts.
• Explain the steps to create a Surface Chart.
• Explain how to change the format and how to format the Surface Chart. 
• Explain how to remove lines from a Surface Chart.
• List the limitations of Surface Chart.
• Explain Contour Charts and list the alternative names of Contour Chart.
• Explain how to create a Contour chart and Surface Chart in Excel 2007.
• Explain Heat Maps, different kinds and uses of Heat Maps
• Explain how to construct the Heat Maps.

2. Surface Charts
A Surface chart shows a three dimensional surface that connects a set of data points. A Surface chart is 
useful to find optimum combinations between two sets of data. Like, in a topographic map, the colours 
and patterns in a Surface chart indicate areas that contain the same range of values. 

In  surface  charts,  colours  are  not  used  to  distinguish  each data  series.  Instead,  colours  are  used  to 
distinguish the values.

A surface chart shows:

 The distribution of sea-level pressure.

 The location and nature of fronts and air masses.

 The symbols of occurring weather phenomena.

 The analysis of pressure tendency (isallobars).

 The indications of the movement of pressure systems and fronts. 
It is also known as sea-level chart; sea-level-pressure chart; surface map.

There are different ways of displaying Surface chart by selecting the following chart sub-types:

3-D Surface: This chart  shows a 3-D view of the data,  which could be imagined as a rubber sheet 
stretched over a 3-D Column chart. It is typically used to show relationships between large amounts of 
data.
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Wireframe 3-D Surface: In this chart, the variation of the 3-D Surface chart appears in black and white.  
A wireframe chart shows only the lines without any colour in the surface.

Contour: A Contour chart provides a 2-D view of the Surface chart similar to a 2-D topographic map. 
The lines in a Contour chart connect interpolated points of equal value.

Wireframe Contour:  A variation  of  the Contour  chart  that  appears  in  black and white  is  known as 
wireframe contour. A wireframe chart shows only the lines without any colour in the surface.

Let us see how to create a Surface Chart:

1. Create  or  copy a data.  Here we have  taken a  data  which  shows the  temperature  as  column 
headings, and the seconds as row headings.

2. Select the data that you want to display in a Surface Chart.

3. On the insert menu, in the Chart group, click Other Charts option.

4. In the other chart type box, under Surface option, click the type you want to use, here we have 
selected 3-D Surface.

5. The 3-D Surface chart is shown in the picture:

When you use this data to create a Surface chart, it will be plotted as follows:

1) The row headings (seconds) appear along the series axis (y-axis).
2) The column headings (temperatures) appear along the category axis (x-axis).
3) The data in the centre of the worksheet (tensile strength) will be plotted along the value axis (z-axis).
(19)

3. Format of a Surface Chart
Now let us see how to change the format of a Surface Chart:
Colours in a Surface chart are based on the values rather than the data series; you cannot select them in 
the chart itself. You can, however, select the corresponding color keys in the chart's legend, and then 
make the formatting changes that you want in the Format Legend Key dialog box. 

Using the Format Legend Key dialog box, you can:

 Change the colours and patterns used in the chart.

 Reorder the data series.
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 Change the depth of the chart.

 Apply 3-D shading.

For example, changing the colours and depth of the previous chart can make a Surface chart much easier 
to read, as shown in the following picture.

Format a Surface Chart:

 On the Surface chart, make sure that the legend is displayed.

 In the legend, click the key for which you want to change the format.

 On the Format menu, click Selected Legend Key.

 On the Patterns tab, make the colour, border, or fill effect changes you want.

 Repeat step 2-4 for each level you want to format.

 To change the order of the data series in the chart, click the Series Order tab, click a series name 
in the Series order box, and then click the Move Up or Move Down buttons.

 To change the depth of the Surface chart, click the Options tab, and then type a value between 20 
and 2000 in the Chart depth box.

 To  add  a  3-D  shading  effect  to  the  Surface  chart,  on  the Options tab,  select  the 3-D 
shading check box.

How to remove lines from a Surface Chart, lets discuss: By default, Excel's surface charts display black 
lines between each color gradient. It's possible to remove those lines, but Excel makes you jump through 
quite a few hoops to do so.

Each line must be removed separately. Lets sees how to do it:

1. Click the chart legend to select it

2. Click the first legend key (that is the small coloured square)

3. Right-click and choose Format Legend Key

4. In the Format Legend Key dialog box, click the Patterns tab

5. Select None for the Border option, and click OK

Repeat those steps for every series in your chart.

The final statement in this procedure turns on the chart's 3D shading option which gives the chart a 
much nicer appearance.

Surface chart has some limitations, they are:
 Surface charts are not true X-Y-Z charts. X and Y are not treated as numeric data, and must 

consist of regularly defined, evenly spaced categories. Exactly one Z value is needed for each X-
Y pair.

 The surface calculations are rudimentary, drawn by connecting Z values at X-Y nodes with 
straight lines and planar sections. A saddle point is not accurately drawn if it occurs between the 
X-Y nodes.

 The colour-filled surface charts do not allow transparency, which would help visualize hidden 
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parts of the surface. (Perhaps Excel for the Mac allows this, but that's insufficient cause to trade 
in your Windows machine for a Mac.)

 The wireframe versions of the surface chart have too many visible line segments, showing both 
the boundaries marking different values and the lines connecting the nodes. They can only be 
hidden and displayed together; whereas it would have been a nice feature to show boundaries 
only, or formatted differently from node connectors.

4. Contour Charts:
A  contour  chart  is  a  graphical  technique  for  representing  a  3-dimensional  surface  by  plotting 
constant z slices, called contours, on a 2-dimensional format. That is, given a value for z, lines are drawn 
for connecting the (x, y) coordinates where that z value occurs.

The contour plot is formed by:

 Vertical axis: Independent variable 2

 Horizontal axis: Independent variable 1

 Lines: iso-response values

This is a two-Dimensional Contour Chart  
This is a three-Dimensional Contour Chart

One common example is:

 Contour map of geographical terrain showing lines of constant altitude.

 Contour charts are used show lines of constant density or brightness, such as in X-ray or CT 
images.

 Contour charts are also used to show lines of constant gravity or electric potential.

There are different alternative names of Contour Charts they are: Isoline Charts, Level Surface Charts 
etc. Let us see a comparison between a standard contour plots with their alternatives.

1. Pseuducolour chart: This is much clear in colour than gray scale. But the only limitation is colour 
is expensive.

2. Mesh Plot or Wireframe Chart: This chart is good for visualizing broad features, but inferior to 
contour plot for precision.

3. Surface Chart/Plot (Surf): This chart is best in colour or has a high-resolution gray scale. Good 
for visualizing broad features, but inferior to contour plot for precision. 

4. Surface Plot with Contour Plot (Surfc): This chart has the advantages of both surface and contour 
plots, but contour plot must be depicted with a slant and can be obscured by the surface plot 
above.

5. Filled Contour Charts (Contourf): This chart is much clearer in colour than gray scale, but colour 
is expensive.

6. Three-Dimensional Contour Chart (Contour3): This chart is visually interesting, but the rings 
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(closed contours) usually overlap making the image sometimes difficult to decode.
7. Three-Dimensional Bar Plot (Bar3): This chart is most useful when (x, y) is defined only for 

discrete values.
8. Three-Dimensional  Stem Plot  (Stem3):  This  is  good for  the  data  which  is  defined only for  

discrete values of (x, y).

5. Creating a Contour chart and Surface Chart in Excel 2007
Let us now know how to create a Contour chart and Surface Chart in Excel 2007.
To make a contour chart in Excel 2007, you need to select the data, and insert the chart.

Scale
You can’t format the legend to adjust the scale of the coloured bands, but you can select the value axis 
using the dropdown on the Chart Tools > Layout or Format tab.

To change the colors of each band, select the legend entry (the legend keys in 2007 cannot be selected) 
and open the formatting dialog. The tabs for fill and border color refer to the formats of the legend key 
and the corresponding band.

Here is the contour plot.

Here is the surface plot with the same scale.

Orientation
The Format Chart Area dialog in Excel 2007 includes a 3-D Rotation pane to allow adjustment of the 
surface chart’s orientation. You can also select the corners in the Excel 2007 surface chart,  but you  
cannot drag them to adjust the orientation of the chart.

Formatting
In Excel 2007 charts, the shading of the contour and surface charts is rather over-the-top. The charts 
have excessive colour gradients to represent the reflections and the brighter and darker clarification 
caused by a light source located at some oblique angle. The gradients are not too severe in a surface 
chart, but in a contour chart, they interfere with interpretation of the values in the bands.

It is possible to remove the light and dark regions in the 2007 charts. If you need to format the band of 
colour, click once on the legend, and then click once on the label of the band you want to format. Then 
right click on this label and choose Format Band from the pop-up menu.

In the Format Band dialog, click on 3-D Format, then click on Material, and under Special Effect, select 
the Flat option.

This removes all of the textures within the band as shown in the below image. Repeat for every band in 
the contour plot.
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Here is the surface chart with all the textures removed.

6. Heat Maps

What is a Heat Maps?
A heat map is a two-dimensional representation of data in which values are represented by colours. A 
simple heat map provides an immediate visual summary of information. 

More elaborated heat maps allow the viewer to understand complex data sets. It  indicates the level 
of activity, usually using darker colours like small dark grey or black squares (pixels) to indicate higher 
or larger values, and lighter colour squares to indicate smaller values. 

The term "Heat map" was originally coined and trademarked by software designer Cormac Kinney in 
1991, to describe a 2D display depicting real time financial market information.

For example:
A heat map could indicate the number of foreclosures in a geographical area during a set period of time. 
In the United States, many people are familiar with heat maps from viewing television news programs. 
During a presidential election, a geographic heat map with the colours red and blue will quickly inform 
the  viewer  which  states  each  candidate  has  won.

There are different kinds of Heat Maps, they are:

 Web heat maps: Web heat maps have been used for displaying areas of a Web page most 
frequently scanned by visitors. Web heat maps are often used alongside other forms of web 
analytics and session replay tools.

 Biology heat maps: Biology heat maps are typically used in molecular biology to represent the 
level of expression of many genes across a number of comparable samples (For example, cells in 
different states, samples from different patients) as they are obtained from DNA microarrays.

 Tree map: The tree map is a 2D hierarchical partitioning of data that visually resembles a heat 
map.

 Mosaic plot: A mosaic plot is a tiled heat map for representing a two-way or higher-way table of 
data. As with tree maps, the rectangular regions in a mosaic plot are hierarchically organized. 
This means that the regions are rectangles instead of squares. 

Uses of Heat Maps are:
A website has a least one goal – whether it’s to communicate information, get users to register or get 
users to purchase a product. Each page on the website contributes to user achieving that goal. By using 
Heat Maps, we can optimize a user’s propensity to reach the goals for the website.   
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Heat Maps can be used to determine the reading patterns of viewers on the website. It also helps in 
determining prime focus areas of the website which in turn helps in placing the right content at the right 
place. Heat Maps are useful for many reasons, some of which includes:

 Knowing exactly how a viewer uses a specific page.

 Seeing which parts of the page are unused.

 Seeing parts of the page that are most used.

 Understanding patterns of use on the site as a whole.

 Predicting how visitors will use the site in the future.

 Using that insight to better cater to the users. 

Let us see how to construct a Heat Maps.
The Heat  Map charts  represents  data  in  a  tabular  format  with  user-defined colour  ranges  like  low, 
average and high. Following sample data are taken to show a heat map:

Open excel 2010. Click on conditional formatting which is found under the “Home” menu ribbon.

To  replicate  the  heat  map  in  the  example,  the  user  should  move  column  by  column,  scaling  the 
background colours across the range of values in the column. Here is an example.

 Select the first column to format.

 From the menu ribbon, select “Conditional formatting,” “Colour Scales”.

 Then select “More rules.” The figure below shows how to navigate to the appropriate spot.

 From the “New Formatting Rule,” select the top option “format all cells based on their values,” 
set the colour of the lowest value to “white”, Percentile to “pink” and the colour associated with 
the maximum value to “red.” The figure below shows the dialog after these steps have been 
completed.

 Below is an example of the resulting column in the workbook after the conditional formatting 
has been applied.

 Result of entire column in the workbook after the conditional formatting has been applied are as 
follows:

 When there are numerous columns to colour, this process can be tedious. The user might find it 
useful to write a macro or VB script to automate the menu selections. Thus, a column would 
need only to be highlighted and the macro executed rather than working manually through the 
menus.
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